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C H A P T E R

Problems Starting Up Your Computer

Problems
Computer won’t start up or restart

Computer won’t start up.

Try these solutions:

m Make sure your computer is getting power. (p. 6)

m Make sure the monitor is properly connected and adjusted. (p. 7)

m Increase memory available for system software. (p. 9)

m “Force” the computer to restart. (p. 12)

m Make sure memory and expansion cards are installed correctly. (p. 14)

m Replace the computer’s backup battery. (p. 14)

Unusual sound occurs when you try to start up the computer.

Try these solutions:

m Make sure external equipment is properly connected and turned on. (p. 7)

m Make sure memory and expansion cards are installed correctly. (p. 14)

m Test and repair hard disk. (p. 14)

Computer won’t restart.

Try these solutions:

m Make sure your computer is getting power. (p. 6)

m Quit open applications. (p. 6)

m Make sure you’re using the correct disk as a startup disk. (p. 10)

m “Force” the computer to restart. (p. 12)

m Reset the PRAM. (p. 13)

Instructions
To continue reading, use the scrollbar on the right. To go to a new section, click its title on the left.
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Single icon appears in middle of screen

Disk icon with blinking question mark appears.

Try these solutions:

m Make sure external equipment is properly connected and turned on. (p. 7)

m Resolve SCSI ID conflicts. (p. 8)

m “Re-bless” the System Folder. (p. 10)

m Resolve system extension conflicts. (p. 11)

m Reset the PRAM. (p. 13)

m Test and repair hard disk. (p. 14)

m Reinstall system software. (p. 15)

Disk icon with X appears.

Try this solution:

m Make sure you’re using the correct disk as a startup disk. (p. 10)

“Sad Macintosh” icon appears.

Try these solutions

m Make sure external equipment is properly connected and turned on. (p. 7)

m Make sure you’re using the correct disk as a startup disk. (p. 10)

m Test and repair hard disk. (p. 14)

m Reinstall system software. (p. 15)

Computer freezes

Computer freezes before “Welcome to Mac OS” appears.

Try these solutions:

m Take notes. (p. 5)

m Make sure external equipment is properly connected and turned on. (p. 7)

m Test and repair hard disk. (p. 14)

m Reinstall system software. (p. 15)

Computer freezes as icons are appearing at bottom of screen.

Try these solutions:

m Take notes. (p. 5)

m Make sure external equipment is properly connected and turned on. (p. 7)

m Resolve system extension conflicts. (p. 11)



m Test and repair hard disk. (p. 14)

m Reinstall system software. (p. 15)

Keyboard or mouse doesn’t work.

Try these solutions:

m Make sure external equipment is properly connected and turned on. (p. 7)

m Resolve system extension conflicts. (p. 11)

m Test and repair hard disk. (p. 14)

m Reinstall system software. (p. 15)

Message appears

Message about system software appears.

Try these solutions:

m Take notes. (p. 5)

m Make sure you’re using the correct disk as a startup disk. (p. 10)

m Reinstall system software. (p. 15)

“Not enough memory” message appears. 

Note:  These solutions are for system software memory problems. For problems with
application memory, see “Problems with Applications, Documents, and Memory” in Chapter 2.

Try these solutions:

m Increase memory available for system software. (p. 9)

m Resolve system extension conflicts. (p. 11)

Disk corruption message appears. 

Try these solutions:

m Take notes. (p. 5)

m Check RAM disk settings in Memory control panel. (p. 9)

Normal desktop doesn’t appear

Screen is dark.

Try these solutions:

m “Wake up” your computer. (p. 5)

m Make sure your computer is getting power. (p. 6)

m Make sure the monitor is properly connected and adjusted. (p. 7)
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No icons appear in windows, and pointer alternates between an arrow and a
wristwatch.

Try this solution:

m Reset window display. (p. 9)

Empty flashing box appears.

Try these solutions:

m “Re-bless” the System Folder. (p. 10)

m Reinstall system software. (p. 15)

Large folder-shaped areas containing pictorial buttons appear.

Try this solution:

m Make sure you’re using the correct disk as a startup disk. (p. 10)

Hard disk icon doesn’t appear on desktop

Try these solutions:

m Restart your computer. (p. 5)

m Make sure external equipment is properly connected and turned on. (p. 7)

m Resolve SCSI ID conflicts. (p. 8)

m Test and repair hard disk. (p. 14)

Computer starts up from wrong disk

Try these solutions:

m Make sure external equipment is properly connected and turned on. (p. 7)

m Resolve SCSI ID conflicts. (p. 8)

m Make sure you’re using the correct disk as a startup disk. (p. 10)

m Reset the PRAM. (p. 13)

m Test and repair hard disk. (p. 14)

PowerBooks: Sleep indicator light glows steady green

Try these solutions:

m Make sure your computer is getting power. (p. 6)

m “Force” the computer to restart. (p. 12)
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Solutions
Take notes.

If you see an error message or the screen freezes, you don’t have to take action immediately.
First, note the following information:

m the error message and its ID number (if any)

m what you were doing when the problem occurred

m the programs you were using

m software you have installed recently (especially items that have been added to the 
System Folder)

m clues on the screen—is a menu selected? What programs and document icons are open? 

m anything else that seems relevant

If you were typing text, write down any text still visible on the screen so that some of your
work will be easy to replace.

Return to the “Problems” section on pages 1–4.

“Wake up” your computer.

If your screen is dark, a screen saver program may have darkened your screen, or the
computer or monitor may have “gone to sleep” (to save energy) because it was inactive. Try
the following:

m Turn off the screen saver by pressing a key or moving the mouse.

m “Wake up” your computer by pressing the Power key (marked with a π) on the keyboard.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Restart your computer.

Often you can eliminate a problem simply by restarting your computer, which clears the
computer’s memory.

1 If you can, save any open documents before restarting.

If your system is frozen or if you have a bomb message on the screen, saving may not be
possible. You can try pressing Command (x)-period to cancel the current operation; if this
works, you can then save the open documents before restarting.
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2 If you can, choose Restart from the Special menu or from the dialog box that’s on screen.

If the computer freezes after you choose Restart, see “Quit Open Applications,” next.

3 If you can’t choose Restart, press the Power key (marked with a π) on the keyboard.

Click Restart in the dialog box that appears.

4 If the Power key doesn’t work, force a restart by holding down the Command (x) and
Control keys while you press the Power key. 

5 If your computer still doesn’t restart, turn off your computer using the power switch. If this
doesn’t work, or if your computer doesn’t have a power switch, unplug your computer.

6 Wait at least 30 seconds, then reconnect the power plug (if necessary) and turn your
computer on again by pressing the Power key on the keyboard.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Quit open applications.

When you restart your computer, the computer tries to quit all open applications. Sometimes
an application doesn’t get the message to quit and you have to quit the application yourself.
You can quit almost any application by choosing Quit from the File menu or pressing
Command (x)-Q.

If this doesn’t work, you can sometimes “force” a program to quit by simultaneously pressing
the keys Command (x), Option, and Esc. Then click Force Quit in the dialog box that appears.

Note:  Unsaved changes in your current documents will be lost.

Immediately save all open documents, quit all other open programs, and restart your computer.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Make sure your computer is getting power.
m Check that the power cord is plugged into a working outlet. If it’s plugged into a power

strip, make sure the power strip is turned on. 

m PowerBooks:  Make sure the battery is properly seated in its compartment. If the battery
needs recharging, plug the power cord into a working outlet and then plug the power
adapter into the computer. Let the battery recharge for a few minutes.

m PowerBooks:  If you’re using the power adapter, it should get warm after being plugged in
for 10 minutes. If it remains cold, make sure the adapter is securely plugged in and
attached to the power cord. 

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.
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Make sure the monitor is properly connected and adjusted.
m Check that the monitor’s brightness (¤) and contrast (O) controls are adjusted properly.

m Turn off your computer. For external monitors, check that the monitor cable is firmly
connected to both the computer and the monitor, and that the monitor is plugged in and
turned on.

m If possible, borrow a monitor that you know works with another Macintosh computer and
connect it to your computer. If the borrowed monitor works, then your monitor may
need repair. Consult an Apple-authorized service provider.

Note:  If you are displaying video from your computer on a television screen, it may be
normal for your computer monitor to be dark. See your computer’s setup manual for
information about connecting a television to your computer.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Make sure external equipment is properly connected and
turned on.

m Shut down your computer by pressing the Power key (π) and then clicking Shut Down.
Make sure all external devices are properly connected and turned on. Check the following,
then restart your computer:

m make sure connectors are plugged in all the way

m make sure thumbscrews are secure

m make sure terminators are secure and their clips are fastened

m If that doesn’t work, then shut down your computer again. Turn off and disconnect all
external equipment (except your monitor and keyboard). Then restart the computer. To
determine which piece of equipment is causing the problem, reconnect them one by one,
turning off your computer before connecting each device. Start up your Macintosh each
time until the problem recurs. When you determine which piece of equipment is causing
the problem, refer to the manual that came with the equipment, as well as the information
on connecting equipment in the setup manual that came with your computer.

Warning Make sure you turn off both your computer and all external equipment
before connecting or disconnecting equipment.

Warning Make sure you turn off both your computer and all external equipment
before connecting or disconnecting equipment.
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Note:  If you have a printer connected to your computer’s SCSI port, make sure your
printer is connected properly. Most printers connect to the printer port, not the SCSI
port. Check the manuals that came with your printer for information on how to connect 
it properly.

m If you suspect a keyboard or mouse problem, shut down your computer. Clean your
mouse as described in the setup manual that came with your computer. Borrow a
Macintosh keyboard or mouse from another computer and connect it to yours. If that
solves the problem, you may need to repair your keyboard or mouse. Consult an Apple-
authorized service provider.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Resolve SCSI ID conflicts.

Each SCSI (Small Computer System Interface) device connected to your computer must have
a unique ID number, from 0 to 7. If you have external SCSI devices (such as disk drives),
make sure they don’t have the same ID number as one another or as SCSI devices inside
your computer. Internal SCSI devices typically have the following ID numbers:

Internal device ID

Hard disk 0

CD-ROM drive 3

Zip drive 5

Macintosh computer 7

Note:  Some computers have two separate SCSI chains, each with its own set of ID numbers.
Also, some computers have an ATA or IDE drive, which is not part of the SCSI chain and
therefore does not have a SCSI ID number. See the technical information booklet and the
setup manual that came with your computer. 

Make sure that the SCSI chain is properly terminated. In general, the first and last device of
each SCSI chain must be terminated. 

See your computer’s setup manual and the documentation that came with your SCSI
equipment for specific details on setting SCSI ID numbers and terminating SCSI devices.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.
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Check RAM disk settings in Memory control panel.

If you’re using a RAM disk and you get a disk corruption message, click Cancel to close the
message. Check the RAM disk settings in the Memory control panel to make sure that you
aren’t trying to create a RAM disk larger than the amount of free space on your hard disk.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Increase memory available for system software.

If you’re having trouble starting up your computer, there may not be enough memory to
load all the system software extensions you’ve installed. Restart the computer, holding down
the Shift key until you see the message “Extensions Disabled” in the “Welcome to Mac OS”
box. Then try the following:

m Turn on (or increase) virtual memory in the Memory control panel. Your computer will
perform well with virtual memory set up to twice the amount of RAM in the computer; for
best performance, limit virtual memory to 1.5 times the amount of RAM.

m Reduce the size of the disk cache in the Memory control panel.

m If you use a RAM disk, reduce its size or turn it off in the Memory control panel.

m Use the Extensions Manager control panel to turn off extensions you don’t need. (You can
use the Extensions Manager to create different sets of extensions for special situations.)

You need to restart the computer for these changes to take effect. See Mac OS Help
(available in the Help menu) for more information about using virtual memory, a RAM disk,
and the Extensions Manager.

If the problem persists, try performing a clean installation of system software. See Chapter 5,
“Reinstalling Your Computer’s Software.”

If none of these suggestions work, install additional RAM in your computer. See the setup
manual that came with your computer.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Reset window display.

There may be a problem with the display of the windows. Restart the computer and hold
down the Option key until the desktop icons appear. (When the desktop appears, all
windows will be closed.)

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.
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“Re-bless” the System Folder.

If your computer is not recognizing the system software, the System Folder may need to be
“re-blessed.” 

1 Start up your computer from the system software CD.

See Chapter 3, “Starting Up From a CD or Floppy Disk.”

2 Open the System Folder.

3 Double-click the System suitcase.

4 After the System suitcase opens, close the suitcase and System Folder windows and restart
your computer.

If this doesn’t work, then try the following:

1 Drag the System suitcase and Finder out of the System Folder.

2 Close the System Folder.

3 Put the System suitcase and Finder back into the System Folder. 

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Make sure you’re using the correct disk as a startup disk.

At least one disk drive must have system software on it from which the computer can start
up. Most computers have an internal hard disk that is used as the startup disk. 

If large folder-shaped areas containing pictorial buttons appear when you start up, you
probably started from a CD containing At Ease, an alternative to the Macintosh desktop.

You can specify the startup disk by using the Startup Disk control panel. See Mac OS Help
(available in the Help menu) for instructions.

Floppy disk:  If your computer is trying to start up from a floppy disk that doesn’t contain
system software, an icon with an X in it appears on your screen. After a few seconds, the
computer should eject the disk and start up from your hard disk. If this doesn’t work, see
“Disk Is Jammed” in Chapter 2.

CD-ROM or DVD disc:  If your computer is trying to start up from a CD or DVD, press the
Open/Close button of your drive to open the tray, then remove the disc. Close the tray and
restart your computer.
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Note:  If your computer started up from a CD, the disc will not be automatically ejected
when you shut down. Restart the computer while pressing the Open/Close button of the
drive. The tray should open so you can remove the disc. If the tray won’t open, see “Disk Is
Jammed” in Chapter 2.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Resolve system extension conflicts.

If your computer does not start up properly or behaves erratically, you may have an
extension or control panel that is not compatible with another extension or control panel, or
with an application or system software.

Verify the problem

To verify that you have a compatibility problem:

1 Start up your computer while holding down the Space bar.

This opens the Extensions Manager control panel. 

2 Release the Space bar when the Extensions Manager control panel opens.

3 Notice the name of the currently selected set of extensions in the Selected Set pop-up menu
so that you can return to it later if you want.

4 Open the Selected Set pop-up menu and choose the “Mac OS 8.0 base” set.

This makes the computer start up using only the software installed at the factory.

5 Click the Continue button to continue startup.
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6 When the computer is ready, try the same actions that caused the problem.

If the problem no longer occurs, you probably have one or more extensions or control
panels that don’t work with Mac OS 8. Continue with the steps that follow in “Test Individual
Extensions and Control Panels.” 

Test individual extensions and control panels

1 Restart your computer while holding down the Space bar.

2 Release the Space bar when the Extensions Manager control panel opens.

3 Click the Duplicate Set button to create a new set. In the window that appears, type a name
for the set (for example, “Test Set”) and click OK.

4 Turn off all the extensions in the new set by choosing “All Off ” in the Selected Set pop-up menu.

5 Turn on the item you want to test by clicking its checkbox.

6 Click the Continue button to continue startup.

7 Try the same actions that caused the problem.

If the problem occurs again, the item is probably incompatible. Remove the item from the
Extensions folder or turn the item off using the Extensions Manager.

8 Repeat steps 1 through 7 for each item you want to test.

If you find that a piece of software is incompatible, contact the manufacturer of the software
to see if an updated version is available.

Tips:  A recently installed extension or control panel might be the problem. If you have a lot
of extensions and control panels, you may want to “work by halves.” Turn on half the
extensions and control panels and test for the problem. If the problem disappears, repeat the
process turning on half of the remaining items. If the problem persists, repeat the process
turning off half of the items that are turned on. Continue to work by halves like this until you
locate the conflicting extensions or control panels.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

“Force” the computer to restart.

Press the Command (x), Control, and Power keys simultaneously. 

Important  Force a restart only when the normal Restart command (in the Special menu)
does not work. 

Note:  When you force a restart, the computer thoroughly tests the RAM. It may take a few
moments (about 1 second per megabyte of RAM) before the screen image reappears.
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If the forced restart doesn’t work, use the power switch (marked with the icon I, called the
“reset button” on PowerBooks) to turn off your computer. If your computer doesn’t have a
power switch, unplug the computer.

Wait 30 seconds, then plug the computer back in, if necessary, and restart by pressing the
Power key (marked with a π) on the keyboard.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Reset the PRAM.

Your computer stores information in an area of memory called parameter RAM (PRAM).
Resetting the PRAM replaces the information stored there with the default (original) settings. 

When you reset the PRAM, preferences for serials ports, video, and sound are lost. This
affects the settings in some of your control panels, including the following:

m Memory (information lost includes RAM disk settings)

m Monitors & Sound

m Keyboard and Mouse (or Trackpad)

m AppleTalk (“Connect via” is set to the Printer port)

m Power Manager

m Map

You may want to make a note of the settings in these control panels before resetting PRAM.

Some third-party software programs also store information in PRAM. Some video cards may
need to be reconfigured after resetting PRAM, and other aspects of your work may be affected.

Follow these steps to reset the PRAM:

1 Shut down your computer by pressing the Power key (π) and then clicking Shut Down.

2 Make sure the Caps Lock key is not engaged.

3 Position the fingers of your left hand on these keys: Command (x), Option, and R. Locate
the P key, so you can find it quickly for step 4.

4 Press the Power key (π) to turn on your computer. Immediately after you hear the startup
sound, press and hold down the Command (x), Option, and R keys at the same time you
press and hold down the P key.

5 After you hear the startup sound, release the keys. Then immediately press and hold down
the Shift key. Release the Shift key when you see the message “Extensions Disabled” in the
“Welcome to Mac OS” box.
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If you don’t see the “Extensions Disabled” message, wait until startup is complete. Then
press and hold down the Shift key while you choose Restart from the Special menu.
Continue to hold down the Shift key until the message appears.

6 Open the System Folder, then open the Preferences folder.

7 Drag the Display Preferences icon to the Trash.

8 Restart your computer without holding down the Shift key.

The computer starts up with your extensions turned on again.

9 If you had special settings in any control panels, open those control panels to restore the
settings you want.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Make sure memory and expansion cards are installed
correctly.

If you recently installed RAM or an expansion card in your computer, check the installation
information in the setup manual that came with your computer to make sure the card is
properly installed. If you purchased an expansion card from a manufacturer other than
Apple, contact the manufacturer if you need further help.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Replace the computer’s backup battery.

If you have intermittent problems starting up your computer and the date is reset to 1956,
have an Apple-authorized service provider replace the battery. See the service and support
information that came with your computer.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.

Test and repair hard disk.

Follow the instructions in Chapter 4, “Testing and Repairing Your Hard Disk.” 

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.
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Reinstall system software.

Follow the instructions in Chapter 5, “Reinstalling Your Computer’s Software.” 

Note:  If you see a message about system software immediately after you did some “house
cleaning” on your computer, you may have inadvertently removed the system enabler file
from the Extensions folder. If you didn’t throw the enabler away, you may be able to repair
your system by dragging the file back into the Extensions folder.

1 Start up your computer from the system software CD or floppy disk, as described later in 
this handbook. 

2 Locate the enabler file. The system enabler is usually named “System Enabler <version
number>.” For PowerBooks, look for “PowerBook <version number> Enabler.” 

3 Drag the system enabler onto the System Folder. Click OK in the message that appears.

4 Restart your computer.

If this doesn’t solve your problem, return to the “Problems” section on pages 1–4.
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C H A P T E R

Problems Using Your Computer
Problems with applications, documents, and memory

“Not enough memory” message appears.

All the memory in your Macintosh is in use by other application programs, system software,
and system resources.

m Quit other open programs to free memory, then open the program you want to use.

m Follow these steps to allocate more memory to the program:

1 Choose About This Computer from the Apple (K) menu. Take note of the number in
the Largest Unused Block section. This number tells you how much memory is
available to open programs.

2 Quit the program if it’s open, select its icon, and choose Get Info from the File menu.
Take note of the numbers in the Minimum Size and Preferred Size boxes. 

3 If the number in the Minimum Size box is larger than the largest unused block, not
enough memory is available to use this program. To free memory, quit open programs
or restart the computer. You can also type a smaller number in the Minimum Size box
if you want to open the program using less memory. But some programs don’t work
well if you assign them less memory.



4 If the number in the Preferred Size box is smaller than the largest unused block, you
may need to assign more memory to the program. (A program may need more
memory if you are working with complex documents.) Type a larger number in the
Preferred Size box.

m Use the Memory control panel to reduce the size of the disk cache, remove or reduce the
size of your RAM disk, or turn on virtual memory. For more information, use Mac OS Help
(choose Help from the Finder’s Help menu).

Note:  If you are using a Power Macintosh MP model, you may not want to turn on virtual
memory. For more information, see the setup manual that came with your computer.

Note:  If you have both virtual memory and a RAM disk turned on in the Memory control
panel, don’t set both of them at or near their maximum values. Doing so can result in
unpredictable or reduced performance by your computer. (A RAM disk uses random-
access memory, or RAM, as if it were a hard disk.)

m Disable system extensions that you don’t need. For more information, see the topic on
system extensions in Mac OS Help (choose Help from the Finder’s Help menu).

m If you have installed system software additions from the Apple Extras folder, you may want
to remove them if you are not using them. (This software can decrease the amount of
memory available for use by application programs.) To remove a system software
addition, run the system software Installer and follow the steps for a custom installation.
See Chapter 5.

m If you frequently want to open more programs than memory allows, you may want to install
more random-access memory (RAM). See the setup manual that came with your computer.

Computer “freezes.”

m Your computer may be trying to complete a task, but it’s taking so long that it seems that
the screen has frozen. If you need to do something else instead, try simultaneously
pressing the Command (x) key and the period key (.) to cancel the task the computer is
working on.

m There may be a temporary software problem that can be fixed by restarting your
computer. See “Restart Your Computer” in Chapter 1.

If the problem recurs, it may involve one or more of your application programs. See the next
entry for additional suggestions.
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Software quits unexpectedly.

The application program needs more memory, or there is a software problem.

m Write down what you were doing when the message appeared, and write down the text of
the message. This information may help a technical support representative diagnose your
problem if you later need to contact Apple or the manufacturer of the application program.

About the codes in error messages:  The number codes in error messages are used in
software development. Sometimes they can help a technician narrow down the source of
a problem. However, the codes are usually too general or technical in nature to help you
diagnose a problem yourself.

m Restart your Macintosh. (See “Restart Your Computer” in Chapter 1.) Most software
problems are temporary, and restarting the computer usually corrects the problem.

m Check for multiple System Folders on your startup disk, using the Find File command.
Throw away extra System Folders. The System Folder that your computer is using has a
small computer icon on it, which distinguishes it from any other System Folder.

m Check for viruses on all your disks, using a virus-detection program. Eliminate any viruses
the program finds.

m Use the program’s Get Info window to give it more memory. (Select the program’s icon
and choose Get Info from the File menu.) See “‘Not Enough Memory’ Message Appears”
at the beginning of this chapter.

m If the problem occurs when you are trying to print, there may not be enough memory for
printing. Quit other open programs to free memory.

m If the problem only occurs in one application program, check for multiple copies of the
program on your hard disk. Use the Get Info command to check the programs’ version
numbers. Keep one copy of the latest version and throw away all other copies.
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Also, try reinstalling the program from the original disks. If reinstalling doesn’t solve the
problem, contact the manufacturer of the program to see if the program contains software
errors or “bugs” and if it is compatible with the version of system software you’re using.

m Sometimes incompatible system extensions or control panels can cause system software
problems. Restart while holding down the Shift key; this temporarily turns off all system
extensions.

If your computer works normally after you do this, use the Extensions Manager control panel
(in the Control Panels folder in the Apple [K] menu) to turn on extensions and control
panels one at a time. Restart after you turn on each extension and control panel. This
procedure should identify incompatible extensions and control panels. (If you just added
new software to your computer, its system extension is the most probable cause of the
problem.) See “Resolve System Extension Conflicts” in Chapter 1.

If your computer performs better when a particular extension or control panel is turned off,
contact the software’s manufacturer for information or an upgrade.

m If the problem recurs, you may need to reinstall system software. See Chapter 5,
“Reinstalling Your Computer’s Software,” for instructions.

Application won’t open.

m The application program may already be open. Check the Application menu to see which
programs are running.

m There may not be enough memory available to open the program. Quit any programs
you’re not using and try again. If that doesn’t work, try restarting the computer. 

You can also use virtual memory to make more memory available to your programs. You
turn on virtual memory in the Memory control panel. See the information about the
Memory control panel in Mac OS Help (choose Help from the Finder’s Help menu).

m The program isn’t requesting as much memory as it needs. Use the program’s Get Info
window to give it more memory. See “‘Not Enough Memory’ Message Appears” at the
beginning of this chapter.

m If the program is on a floppy disk, make sure the disk is unlocked. ( You unlock a disk by
sliding the tab at the corner of the disk so that it covers the hole.)

m The program may be damaged, or it may not be compatible with PowerPC™ technology.
Check to make sure the software is PowerPC-compatible, and install it from a known good
source (such as the original program disks).

m Check that the program is compatible with the version of system software that you are
using. (See the program’s documentation, or contact the manufacturer or vendor.)
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Application won’t open because a file can’t be found.

Macintosh programs designed specifically for the PowerPC microprocessor (also called
“native” applications) use special files called “shared libraries.” Any necessary shared libraries
should be installed automatically when you install these special Macintosh programs.

Follow the directions that came with your program to reinstall it. If the shared library is still
missing, contact the software program’s manufacturer for assistance.

Document won’t open, or application program can’t be found.

The document may have been created with a program that is not on your hard disk, or with a
different version of the program.

m Try starting a program that you think might be able to open the document. Then choose
Open from the program’s File menu to open the document. For more information, see
the documentation that came with the program.

m Purchase and install the correct software to use the document, or find out if the creator of
the document can convert it to a form that one of your programs can use.

m Rebuild your desktop. To rebuild the desktop, hold down the Command (x) and Option
keys on the keyboard while you restart the computer.

m Don’t try to open the files in your System Folder. Most of the files in your System Folder
are used by your computer for internal purposes and are not intended to be opened.

m If the document is from a DOS or Windows computer, see “DOS or Windows Document
Won’t Open, or Displays Incorrectly,” later in this section.

Document can’t be saved. 

m A CD-ROM disc is a read-only medium. This means that information can be read
(retrieved) from it, but not written (stored) on it. You can save the changed information
on a hard disk or floppy disk. 

“QuickDraw 3D could not be found” message appears.

m Make sure that the following files are in the Extensions folder, inside the System Folder:

m QuickDraw 3D

m QuickDraw 3D RAVE

m QuickDraw 3D Viewer

m QuickDraw 3D IR

If the files are there and you still get the message, it means that you don’t have enough
memory to run the application. You may be able to open the application if you try one or
more of the following:

m Quit other open applications.
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m Reduce the amount of memory allocated to the application: 

1 Select the application’s icon in the Finder.

2 Choose Get Info from the File menu.

3 Type a lower number in the box for Preferred Size.

m Install more memory (RAM).

DOS or Windows document won’t open, or displays incorrectly.

If you can’t open a DOS or Windows document by double-clicking its icon, try one of 
the following:

m Open the document from within the program by choosing Open in the program’s File menu.

m Use the PC Exchange control panel (in the Control Panels folder in the Apple [K] menu)
to specify which Macintosh program will open the document.

If a DOS document is displayed incorrectly, or you see strange codes or characters in the
document, try one of the following:

m Your application program may have special procedures for opening and saving documents
with different file formats. See the information that came with your program, or call the
program’s publisher.

m Try opening the document in another program.

Note:  Some characters that can be displayed on the Macintosh are not accurately displayed
on DOS computers. 

See information about working with DOS or Windows documents on your Macintosh in 
Mac OS Help (choose Help from the Finder’s Help menu).

Can’t throw away a file.

m The file may be locked. Select the file’s icon, choose Get Info from the File menu, and click
the Locked checkbox to remove the X. You can delete locked files that are in the Trash by
holding down the Option key while you choose Empty Trash from the Special menu.

m An application program may be using the file. Close the file or quit the program.

m If the file is on a floppy disk, the disk may be locked. Unlock the disk by sliding the tab so
that it covers the hole at the corner of the disk.

m The file may be in a shared folder that can’t be changed. You can throw away the file by
turning off file sharing temporarily (click Stop in the File Sharing control panel). Or you
can select the shared folder, choose Sharing from the File menu, and uncheck the box
labeled either “Can’t be moved, renamed, or deleted” or “Same as enclosing folder.”



Older Macintosh programs don’t work properly.

Some older Macintosh programs are not completely compatible with Macintosh computers
that have the PowerPC microprocessor.

m Contact the program’s publisher to see if an upgrade is available.

Window disappears.

m Another open window may be covering the one you’re looking for. Move, resize, close, or
hide windows until you see the one you want.

m The program the window is associated with may be hidden. Choose Show All from the
Application menu and then click the window you want, or choose the program from the
Application menu.

Can’t quit program opened from Launcher.

Some programs in the Learning section of the Launcher (when you press the Learning
category button) are self-running demos. If you can’t get out of one of the programs or
demos, try the following:

m Look again to see if you can find a Quit button or other quitting option.

m Hold down the Command (x) key on your keyboard and, while holding it down, press
the period key.

m While holding down the Command (x) key on your keyboard, press the Q key.

m Press the Power key (marked with a π) on your keyboard and then press Return to shut
down the computer.

m Restart your computer by holding down the Command (x) and Control keys while you
press the Power key (marked with a π).

Energy Saver control panel keeps displaying and dismissing dialog boxes.

m The Document Auto-Save feature that automatically saves any open unsaved documents
when the computer shuts down has experienced a problem. To return to normal
operation, press the mouse button or press the Space bar on the keyboard.

Problems with hard disks, CDs, and other storage media

Disk is jammed

The normal way to remove a disk from your computer is to drag its icon on the desktop to
the Trash. Removable disks are usually ejected when you shut down your computer.

Warning  Turn off your computer before you attempt to remove a jammed disk. If
you don’t, you may damage the drive.
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If a disk is jammed, shut down your computer. Locate the small hole near the disk drive’s
opening, and carefully insert the end of a large straightened paper clip. Push gently until the
disk is ejected. Do not use excessive force. 

Zip disk:  Use a small paper clip for built-in Zip disk drives.

Problems with hard disks

Can’t mount Mac OS, DOS, or ProDOS partitions.

m Use Macintosh PC Exchange to mount these partitions as individual volumes on the
desktop. (Macintosh PC Exchange is a control panel that is part of system software. When
used with a DOS-compatibility card and its accompanying software, Macintosh PC Exchange
allows your Macintosh to communicate with non-Macintosh software and hardware.)

Note:  If the disk contains both Mac OS– and DOS-format partitions, Macintosh PC Exchange
will recognize only the Mac OS partition. Also, Macintosh PC Exchange can recognize
ProDOS-format partitions only on SCSI hard disks that are less than 32 MB.

Can’t resize Mac OS, DOS, or ProDOS partitions.

m To resize or reformat multiple Mac OS, DOS, or ProDOS partitions, you need to use third-
party software designed for partitioning hard disks and removable media cartridges.

Can’t eject removable media (such as a cartridge).

m The Eject Disk command is unavailable when you are working with removable media
devices. To unmount and eject a removable media cartridge, select the device’s icon and
choose Put Away from the File menu. Once the device has stopped spinning and its light
goes out, you can manually eject the cartridge from the drive. To access a removable
media cartridge that has been ejected, simply reinsert the cartridge in the drive.

Problems with CD-ROM drives and discs

Icon doesn’t appear on desktop.

m Make sure that the disc label is facing up and the disc is centered in the tray. 

Important  If you’re using a small (8 cm) disc, make sure it’s centered within the tray’s
inner ring and the computer is absolutely level. An improperly seated small disc in your
computer may result in damage to the disc, the CD-ROM drive, or both.

Emergency ejection hole
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m Make sure the tray is closed all the way.

m Try restarting your computer.

m Make sure that the Apple CD-ROM extension is turned on in the Extensions Manager
control panel. (Open the Extensions Manager control panel in the Control Panels folder in
the Apple [K] menu). Then restart your computer.

m The disc may use a format that the Macintosh cannot recognize. Ask the disc’s
manufacturer for a disc that a Macintosh can recognize.

m Try starting up your computer from the system software CD that came with your
computer. Insert the CD and restart while holding down the C key. (See Chapter 3,
“Starting Up From a CD or Floppy Disk.”) If only the hard disk icon appears on the
desktop, then there may be a hardware problem with your CD-ROM drive. If the CD-ROM
disc icon appears above the hard disk icon, reinstall your CD-ROM software. The easiest
way to do this is by reinstalling your system software. See Chapter 5, “Reinstalling Your
Computer’s Software.”

m If you have SCSI devices (anything connected to the SCSI port [g]) attached to your
computer, make sure that each device has a unique SCSI ID number (your CD-ROM drive
has SCSI ID 3). See “Resolve SCSI ID Conflicts” in Chapter 1 and the documentation that
came with your SCSI devices if you need to reset SCSI ID numbers.

m If you installed a CD-ROM drive after you bought your computer, make sure the CD-ROM
software that came with the drive is installed. See the manual that came with the CD-ROM
drive. (The CD-ROM software is already installed on Macintosh computers that came with
CD-ROM drives.)

Disc is vibrating in the drive.

Some CD-ROM disc labels have artwork that is noticeably thicker on one side than the other
and can cause the disc’s weight to be slightly off-center. This uneven distribution of weight
coupled with the high rotation speed of your CD-ROM drive can cause some discs to wobble
in the drive and make your computer vibrate. The vibration damages neither the CD-ROM
disc nor the computer and affects very few CD-ROM discs. If you can feel or hear that the
CD-ROM disc is vibrating in the computer, you don’t need to do anything special; continue to
use the CD-ROM disc as you normally would. 

Note:  If you use a CD-ROM disc with a removable (sticky) label, remove the label before
inserting the disc.

Tray won’t open. 

If a CD-ROM disc icon appears on your screen:

m Select the disc icon and choose Put Away from the File menu, or drag the icon to the Trash.

Note:  You won’t lose information on the CD by dragging its icon to the Trash.
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If the AppleCD Audio Player is active, choose Eject CD from the File menu or click the
eject button in the AppleCD Audio Player controller.

If you see a message that a disc can’t be put away because it is being shared, turn file
sharing off in the File Sharing control panel in the Control Panels folder, available in the
Apple (K) menu.

If no CD-ROM disc icon appears on your screen:

m Restart your computer. Immediately after you hear the startup chime, press the
Open/Close button of your CD-ROM drive.

m The signal to open the tray may not be reaching the computer. Manually remove the disc,
as described in “Disk Is Jammed,” earlier in this section.

If neither of these suggestions works, your CD-ROM drive may be damaged. Contact an
Apple-authorized service provider or Apple for further assistance.

Can’t eject disc. 

m If file sharing is on and you are having trouble ejecting a disc, turn file sharing off in the
File Sharing control panel in the Control Panels folder, available in the Apple (K) menu.

“This is not a Macintosh disk: Do you want to initialize it?” message appears. 

m Make sure that the Foreign File Access extension is installed and turned on. Use the
Extensions Manager control panel in the Control Panels folder in the Apple (K) menu to
turn it on, then restart your computer.

m The disc may use a format that the Macintosh cannot recognize. Ask the disc’s
manufacturer for a disc that a Macintosh can recognize.

m Make sure the CD-ROM software is installed. (The CD-ROM software is already installed
on Macintosh computers that come with CD-ROM drives.) The easiest way to install 
CD-ROM software is by reinstalling your system software. See Chapter 5. If you installed a
CD-ROM drive after buying your computer, see the manual that came with the drive.
Restart your computer after installing CD-ROM software.

Computer ejects disc unexpectedly. 

m Make sure the disc is lying flat in the tray and the disc label is facing up. 

Important  If you’re using a small (8 cm) disc, make sure it’s centered within the tray’s
inner ring and the computer is absolutely level. An improperly seated small disc in your
computer may result in damage to the disc, the CD-ROM drive, or both.

m The disc may need to be cleaned. (See the setup manual that came with your computer.)
If there are visible scratches on the shiny side of the disc, you may be able to remove
them with a CD-ROM disc polishing kit (available from your audio CD dealer). If the
scratches can’t be removed, you need to replace the disc.
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m The disc may be damaged. Try another disc in the drive, and try the original disc in
another drive. If the original drive reads other discs or if the original disc also doesn’t
work in another drive, the disc is probably damaged. You need to replace it.

Problems using ISO 9660 or High Sierra discs

Files can’t be opened.

m Discs in the ISO 9660 and High Sierra disc formats have version numbers attached to file
names. Some application programs need these version numbers in order to work with
files. To make the version numbers available to programs on your computer, drag the 
CD-ROM disc icon to the Trash. When the tray opens, hold down the Option key and
push the tray back in. Continue to hold down the Option key until the disc is mounted 
in the drive. The program you are using should now be able to locate file names on that
CD-ROM disc.

m Make sure that the Foreign File Access, ISO 9660 File Access, and High Sierra File Access
files are present in the Extensions folder in the System Folder on your hard disk. If these
files are not present, reinstall your CD-ROM software. The easiest way to do this is by
reinstalling your system software. See Chapter 5, “Reinstalling Your Computer’s Software.”

Problems using Photo CDs

Icon doesn’t appear on desktop.

m Reinstall the CD-ROM and QuickTime software. The easiest way to do this is by
reinstalling your system software. See Chapter 5, “Reinstalling Your Computer’s Software.”

Color icons for individual images don’t appear.

m Your computer may be low on memory. To view color icons, restart your computer and then
reopen the Photos folder. See Mac OS Help (choose Help from the Finder’s Help menu).

Image is scrambled, colors are displayed incorrectly, or no image appears.

m The program you are using may not be designed to work with large (high-resolution)
image files. You can open the image with another program or you can assign more
memory to the program. See Mac OS Help (choose Help from the Finder’s Help menu).

System “freezes,” or “bomb” message appears.

m Restart your Macintosh. (If you need help restarting your computer, see Chapter 1.) The
program you are using may not be designed to work with large (high-resolution) image
files. You can open the image with another program or you can assign more memory to
the current program. See Mac OS Help (choose Help from the Finder’s Help menu).

Problems playing audio CDs

See “Problems With Sound and Video,” later in this chapter.



Problems with floppy disks and floppy disk drives

Can’t eject disk.

If you can’t eject a floppy disk in the usual way, by selecting the disk’s icon and choosing Put
Away from the File menu or by dragging the disk’s icon to the Trash, try the following in order:

m Hold down the x and Shift keys and press the number 1 key on your keyboard.

m Shut down the computer. If the disk isn’t ejected, then hold down the button on your
mouse or other pointing device while you start up the computer again.

m Manually remove the disc, as described in “Disk Is Jammed,” earlier in this section.

If none of these solutions works, take the computer or disk drive to your Apple-authorized
service provider to have the disk removed.

Can’t save or copy files.

m The disk may be locked. Unlock it by sliding the tab at the corner of the disk so that it
covers the hole.

m The disk may be full. Throw away items on the disk that you no longer need, or save the
files on a different disk.

m The disk may be damaged. Test it with Disk First Aid, which is located on the system
software CD.

m The disk drive may be damaged. To see if this is the problem, try saving or copying files
onto another floppy disk. If you are still unsuccessful, the drive may need professional
repair. Contact your Apple-authorized service provider or call Apple for assistance.

“This is not a Macintosh disk: Do you want to initialize it?” or “This disk is
damaged: Do you want to initialize it?” message appears.

m The floppy disk may be new and not yet initialized. If you’re sure the disk has never been
used, click Yes. 

m The disk may have been formatted for use on DOS/Windows systems, or some other kind
of computer. If so, see the tips that follow.

m Click No in the dialog box asking you if you want to initialize the disk.

m Make sure the PC Exchange control panel is in the Control Panels folder (in the Apple
[K] menu) and that it is turned on. Also, make sure PC Exchange is enabled in the
Extensions Manager control panel. For more information about the Extensions
Manager, see Mac OS Help (choose Help from the Finder’s Help menu).

Warning  Clicking Yes erases all data that may be on the disk. 
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m When formatting floppy disks on a DOS computer for use in a Macintosh, you need to
format standard double-sided disks as 720K disks and high-density disks as 1440K
disks. Double-sided disks formatted in 1440K format and high-density disks formatted
in 720K format may not work in a Macintosh.

If you think your DOS floppy disk might have a format that doesn’t work in a
Macintosh, use a DOS computer to copy the contents of the disk onto a properly
formatted disk.

m The floppy disk may be too warm or too cold to be read. You can warm up a cold disk
safely by setting it on top of your monitor for a few minutes. You can cool an overly warm
disk by placing it in a shady, cool place.

m The disk drive may be damaged. To see if this is the problem, click No to eject the disk;
then insert the disk into another drive, if you have one. If you still see the message, the
floppy disk may be damaged. If the disk icon appears on the desktop, one of the drives
may be damaged. (When a disk that was written on by one drive cannot be read by
another, the heads on one of the drives are out of alignment. The drive that is misaligned
or broken may not be the drive that cannot read the disk; try the disk in three or four
drives to identify the drive with the problem.)

m If none of these suggestions works, the floppy disk is probably damaged. First use a disk
recovery program to copy the data from your damaged disk onto a good disk. For
instructions, see the documentation that came with the disk recovery program. Then, use
Disk First Aid (located on the system software CD) to repair the damaged floppy disk.

Computer keeps asking you to reinsert disk.

m An application program or document from the floppy disk is still open and is “looking for”
the disk. Reinsert the disk and close the documents or quit the application programs that
are open on the disk. (Go to the Application menu in the upper-right corner of your
screen and make sure that the Finder is the only application listed. If not, select one of
the other application programs and then choose Quit from the File menu. Do this for any
other applications listed in the Application menu.) Then eject the floppy disk by selecting
its icon and choosing Put Away from the File menu.

Problems printing

The following suggestions should work for all printers. 

Note:  Also refer to the manual that came with the printer.

m Make sure that the printer driver for your printer is turned on in the Extensions Manager
control panel in the Control Panels folder in the Apple (K) menu. To find out the name of
the printer driver—for example, LaserWriter—refer to the documentation that came with
your printer.
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m Check your printer settings in the Chooser (in the Apple [K] menu), making sure you
have selected the correct printer. If you are using a printer that is shared by other
computer users (a printer on a local network), make sure that AppleTalk (in the lower-
right corner of the Chooser) is active. If you are using your own printer (a serial printer
connected to your computer), make sure that AppleTalk is inactive.

m Turn off the computer and printer and check the printer cable connections. 

m If none of these suggestions solves the problem, you may need to reinstall the printer
driver that came with your printer. Refer to the manual that came with your printer. 

Important  If you have an Apple printer, you need to determine which printer driver to
reinstall—the one that came with your printer or one of the drivers included on your system
software CD-ROM disc. Depending on when you bought your printer, one of these printer
drivers will be more recent than the other. Reinstall the more recent one.

Can’t print, or error message appears.

m There may not be enough memory for printing. Try the following:

m Immediately after sending the Print command, quit the application you’re printing
from to free memory for printing.

m Increase the amount of memory for the desktop printer icon; select it, choose Get Info
from the File menu, and type a larger number in the Preferred Size box.

m Reduce the amount of memory used by the application you’re printing from.

m If your document uses lots of fonts, choose Page Setup from the File menu. Make sure
you have selected “Unlimited Downloadable Fonts” under PostScript™ Options. If that
doesn’t work, use fewer fonts in the document.

m If the document contains complex graphics, remove some of the detail from the images.

m Make sure the printer is turned on. Some printers need to warm up for a few minutes
after you turn them on.

m The printer may be out of paper or may need attention. Check the printer status lights
and any messages on your screen. 

m Open the desktop printer icon and check for status messages.

m Print a detailed report. (In the Print dialog box, select “Print detailed report” under 
Error Handling.)

m Reinstall your printer software.



Performance and other problems

Performance decreases.

m If you notice a decrease in your computer’s speed and general performance after you
install a control panel or system extension, the software may not be compatible either
with Macintosh computers built with the PowerPC microprocessor or with other system
extensions. See “Resolve System Extension Conflicts” in Chapter 1.

m Use the Memory control panel to turn off virtual memory. See the information about
memory in Mac OS Help (choose Help from the Finder’s Help menu).

Note:  If you turn on both virtual memory and a RAM disk in the Memory control panel,
don’t set both of them at or near their maximum values. Doing so can result in unpredictable
or reduced performance by your computer. (A RAM disk uses random-access memory, or
RAM, as if it were a hard disk.)

m If you still do not notice an improvement, you may want to reinstall system software on
your startup hard disk. See Chapter 5, “Reinstalling Your Computer’s Software.”

m If you typically use several application programs at the same time, your computer’s
performance will increase if you install more random-access memory (RAM). See the
setup manual that came with your computer.

Computer isn’t performing well.

If, after trying the tips in the previous section, your computer still isn’t performing as fast as
you’d like, try these suggestions. Each one will make only a small difference in your
computer’s speed; but if you try them all, you’ll notice the improvement.

m Open the Memory control panel in the Control Panels folder in the Apple (K) menu;
then make these changes:

m In the Disk Cache section, increase the Cache Size slightly. (Because the amount of
memory available for opening programs decreases as you increase the size of the
cache, do not set the Cache Size too high.)

m In the Virtual Memory section, click Off if you haven’t already done so.

m Open the Keyboard control panel in the Control Panels folder; then make these changes:

m Set the Key Repeat Rate to Fast.

m Set the Delay Until Repeat to Short. 

m Turn off Menu Blinking. Open the General Controls control panel in the Control Panels
folder; then click Off in the Menu Blinking section.

m If you don’t need to see thousands or millions of colors on the screen, reduce the color
depth. Open the Monitors & Sound control panel in the Control Panels folder; then select
256 in the Color Depth section.
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m Increase the speed of mouse tracking. Open the Mouse control panel in the Control
Panels folder; then set Mouse Tracking to Fast.

m Make sure your computer is not calculating folder sizes. Choose View Options in the View
menu. Note:  View Options is only available when “as List” is selected in the menu.

Make sure the checkbox next to “Calculate folder sizes” is not selected.

m If your computer is not connected to an AppleTalk network, turn off AppleTalk. Open the
Chooser in the Apple (K) menu; in the AppleTalk section, select Inactive.

3D rendering doesn’t seem to be accelerated.

The performance advantage of any 3D accelerator depends on the type of scene being rendered.
You may find that some applications show the benefits of acceleration more than others. 

Not all computers are equipped with a 3D accelerator. If your computer came with a 3D
accelerator, or you’ve installed one, check the following items:

m Make sure that your monitor resolution is set to 640 x 480 in 16-bit mode (thousands of
colors). Refer to the Technical Information booklet for modes that support 3D acceleration.

m Make sure that your application uses QuickDraw 3D. Some older 3D applications don’t
use QuickDraw 3D for rendering, and cannot be accelerated.

m If the Control Strip is overlapping or touching the 3D window, hide the Control Strip or
move the window.

m Some applications allow you to turn hardware acceleration on or off. Check your
application’s documentation to be sure that hardware acceleration is turned on.

m Check that the following files are in the Extensions folder, which is in the System Folder:

m ATI 3D Accelerator

m ATI Graphics Accelerator

m ATI Video Memory Manager

m Turn off virtual memory. (Apple recommends turning off virtual memory whenever you
use 3D applications.) Open the Memory control panel, click the Off button in the Virtual
Memory section of the control panel, and restart your computer.

Right-angle bracket prompt (>) appears.

Your computer has tried to launch a “debugging” application (perhaps you inadvertently
pressed the Command (x) and Power keys at the same time), but could not find one on
your hard disk. Debugging applications are programs that software developers use to locate
and fix problems in computer code. If you do not have a debugging application installed,
your screen displays a right-angle bracket prompt (>). To return to the desktop or your
application, type G and then press Return.
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Clock doesn’t keep time accurately.

If your clock begins to keep time inaccurately, have an Apple-authorized service provider
replace the battery. Consult the service and support information that came with your
computer for instructions on how to contact an Apple-authorized service provider or Apple
for assistance.

Icons look strange.

m There may be a problem with the information that the computer uses to keep track of
files. To fix this problem, rebuild the desktop. Hold down the Command (x) and Option
keys on the keyboard while you restart the computer.

m You may be using a file-compression program to save space on your hard disk. Some
compression programs change the appearance of icons. 

Font file can’t be opened or moved. 

m The font file may be damaged. Replace the font in the Fonts folder (inside the System Folder).

Blinking icon appears in menu bar.

m A program needs attention. Open the menu and choose the program whose icon is
blinking (it may have a diamond by its name). Respond to any messages on the screen. If
it’s not clear what you should do, consult the documentation that came with the program.

m A program may need your attention. If an icon is blinking in the menu bar, open the
menu, choose the program whose icon is blinking (it may have a diamond by its name),
and take the necessary action. 

m Open the Easy Access control panel (if it is installed on your computer) and check
whether any of its features are turned on. 

Computer makes unusual sounds. 

m Select a different system sound in the Sound control panel.

m If the sounds are regular or melodic, they may be caused by interference from electrical
equipment. Move the computer farther away from any such equipment. 

Warning  Do not attempt to replace the clock battery yourself. If the clock begins to
lose accuracy, have an Apple-authorized service provider replace the battery. The service
provider will dispose of the battery according to the local environmental guidelines.
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Problems with networks and file sharing

If you are having problems using the network or file sharing, try the following before
attempting further solutions:

m Make sure the network is working by opening the Chooser and checking for the shared
disks and printers you usually use.

m Make sure that AppleTalk is turned on in the Chooser.

m Open the AppleTalk and TCP/IP control panels and make sure the settings are correct. See
the topic on file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

m Make sure that all the network software is installed. The Network and AppleShare
extensions should be in the Extensions folder. If you want to use file sharing, the File
Sharing control panel should be in the Control Panels folder, and the File Sharing
Extension should be in the Extensions folder. If any of these items is missing, reinstall the
system software. See Chapter 5, “Reinstalling Your Computer’s Software.”

m Make sure network cables are connected properly. 

Computer you want doesn’t appear in the Chooser. 

m Make sure the computer you’re trying to connect to is turned on.

m Make sure file sharing is active on the computer you’re trying to connect to. (That
computer’s File Sharing control panel should say that file sharing is on.)

Shared disk you want to use is not available.

m You may already be connected to the shared disk. Check for its icon on your desktop.

m You may not have the access privileges you need to use the shared disk. Ask the network
administrator or the owner of the shared item to give you access. See the information on
file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

Can’t see any files on remote computer.

m Make sure that files are being shared on the other computer. The File Sharing Monitor
control panel on that computer lists the items being shared.

m Make sure you have the access privileges you need to view the files. Ask the network
administrator or the owner of the shared item to give you access. See the information on
file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

File sharing can’t be turned on. 

m Make sure AppleTalk is turned on in the Chooser.

m Make sure you have at least 400K of available space on your hard disk. 

m Some disk-formatting programs don’t work with file sharing. If you use such a program,
contact the manufacturer or vendor for compatibility information. 
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m There may be a problem with some of the information your computer uses to start up file
sharing. Follow these steps in order until the problem is solved:

1 Open the File Sharing control panel and enter new information in the Network
Identity section. Then try again to turn on file sharing. 

2 Remove the File Sharing folder from the Preferences folder (inside the System Folder).
Then restart the computer and try to turn on file sharing. 

3 Reset the PRAM by following the instructions in “Reset the PRAM” in Chapter 1. 

4 Remove the Users & Groups Data File from the Preferences folder (inside the System
Folder). Restart the computer.

5 Reinstall system software. See Chapter 5, “Reinstalling Your Computer’s Software.”

Item can’t be shared. 

m Make sure you have at least 1 MB of space available on your hard disk. 

m Some removable storage devices can’t be shared. Check with the manufacturer or vendor
of the device for more information.

m Some disk-formatting programs don’t work with file sharing. If you use such a program,
check with the program’s manufacturer or vendor.

Can’t open a shared disk or folder.

m You may not have the access privileges needed to use the disk or folder. Ask the network
administrator or the owner of the shared item to give you access.

m Check with the owner of the item to make sure you are entering your name exactly as the
owner specified (including spaces and capitalization) and try again.

Problems with sound and video

Can’t hear any sound.

m If you have headphones or speakers connected to the computer, make sure they are
firmly connected. Make sure the volume control on your headphones or speakers is not
turned down too low.

m If you do not have headphones or speakers connected to the computer, make sure that
nothing else is plugged into the computer’s sound output port (-).

m If you are using a CD-ROM disc over a network, you won’t be able to hear the audio portion.

m Make sure the volume is turned up in the AppleCD Audio Player. With the program open,
drag the volume control slider up, use the volume controls on your computer, or press
the Up Arrow key on your keyboard.
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m The CD may have been paused. Click the Play/Pause button in the AppleCD Audio Player.

m If your CD-ROM drive was installed after you bought your computer, make sure the audio
cable is properly connected. See the documentation that came with the CD-ROM drive.

Audio stops playing when you double-click a CD-ROM disc icon.

m You can’t open data files on a CD-ROM disc and listen to audio tracks on it at the same time.

Audio CD begins playing automatically when inserted.

m Your computer is set to automatically begin playing audio CDs when they are inserted. To
turn off this feature, use the QuickTime Settings control panel to change the automatic
play setting. 

Sound comes out of computer even though headphones are plugged into
monitor.

m Plug your headphones into the headphone jack (f) on the front of the computer.

m If your computer has a subwoofer and you want to keep the headphones connected to
the monitor, manually turn down the subwoofer. Turn the knob in the subwoofer balance
control port (Ï) counterclockwise to turn off the subwoofer volume. Remember to turn
it back up the next time you want to hear the subwoofer. 

Sound in headphone is odd.

You may have 3D Surround Sound turned on. 3D Surround Sound doesn’t work
well through headphones. To turn it off, open the Monitors & Sound control panel and click
the Sound icon. Click to remove the X from the the “Enabled” checkbox.

Subwoofer balance control (Ï) doesn’t work.

For computers with a subwoofer, the balance control affects the subwoofer volume only
when the computer has external speakers attached or the monitor has built-in speakers.
Otherwise, the subwoofer balance control (Ï) has no effect on your computer’s overall
volume. Adjust your computer’s volume with the sound controls on the front of the
computer or monitor, with the volume control sliders in the Monitors & Sound control panel
or with the volume controls in AppleCD Audio Player (if you’re listening to an audio CD).

Can’t record from audio CD.

m Check your computer’s sound input port to see if a microphone or other device is connected.

m You may need to reset the sound options in the Monitors & Sound control panel. See the
information on sound in Mac OS Help (choose Help from the Finder’s Help menu).

Can’t record with microphone.

m Make sure your sound input source is set to “External Microphone.” Open the Monitors &
Sound control panel, click the Sound icon, and choose “External Microphone” from the
Sound Input pop-up menu.
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m If you’re using your monitor’s built-in microphone to record, use the Monitors & Sound
control panel to mute the monitor’s speakers. In the same control panel, make sure that
the sound input is set to the monitor’s built-in microphone.

See the information about sound in Mac OS Help (choose Help from the Finder’s Help menu).

“QuickDraw 3D could not be found” message appears.

m Make sure that the following files are in the Extensions folder (inside the System Folder):

m QuickDraw 3D

m QuickDraw 3D RAVE

m QuickDraw 3D Viewer

m QuickDraw 3D IR

If the files are there and you still get the message, it means that you don’t have enough
memory to run the application. You may be able to open the application if you try one or
more of the following:

m Quit other open applications.

m Reduce the amount of memory allocated to the application. Follow these steps:

1 Select the application’s icon in the Finder.

2 Choose Get Info from the File menu.

3 Type a lower number in the box for Preferred Size.

m Install more memory (RAM).
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C H A P T E R

Starting Up From a CD or Floppy Disk
To test, repair, or initialize a hard disk, or to install or remove system software on a hard disk,
you need to start up your computer from another disk. You can start up your computer using
the system software CD-ROM disc, or (if your computer does not have a CD-ROM drive)
from the Disk Tools disk or a floppy disk containing system software.

Starting up from the system software CD

Follow these steps to start up from the CD containing system software.

1 Turn on your computer if it’s not already running.

2 Press the Open/Close button of your CD-ROM drive to open the tray.

3 Place the CD containing system software in the tray with the disc label facing up.

Make sure the disc is lying flat in the tray.

4 Close the tray by pushing in the tray in or pressing the Open/Close button.

5 Hold down the C key on your keyboard while you choose Restart from the Special menu and
wait for the message “Welcome to Mac OS” to appear.

6 When you see the screen that says “Mac OS” and the phrase “Starting Up,” release the C key.

In a few seconds the desktop appears. Since your computer is now running the system
software that’s on the CD, the desktop pattern is different from the pattern you normally
see. The CD’s icon appears at the top-right corner of the desktop (above your hard disk
icon), and the Apple (K) menu does not contain the usual items.
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When you’re done with the CD

When you start up your computer from a CD, the CD cannot be ejected in the usual way. 

To restart your computer from the hard disk and eject the CD:

1 Choose Restart from the Special menu.

2 Immediately after hearing the startup chime, press the eject button on the front of the CD drive.

Note:  You can also change the startup disk by opening the Startup Disk control panel and
selecting the hard disk. Restart your computer. After startup, eject the CD by selecting its
icon and choosing Put Away from the File menu (or by dragging its icon to the Trash).

Starting up from a floppy disk

If your computer does not have a CD-ROM drive, you need to start up with a floppy disk
containing system software in order to test and repair your hard disk or install system
software. See the setup manual that came with your computer for information about
obtaining system software floppy disks.

Follow these steps to start up from a floppy disk containing system software. 

1 Turn on your computer. 

2 Insert the floppy disk containing system software.

If you are testing, repairing, or initializing a hard disk, insert the Disk Tools disk. If you are
installing system software, insert the first disk of the system software disk set.
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C H A P T E R

Testing and Repairing Your Hard Disk
If you see a message reporting that a disk is “damaged” or unreadable, the directory and
other data on your hard disk may have become corrupted. 

Repairing corrupted data on your disk

Most data corruption can be fixed easily by using Disk First Aid. Disk First Aid is on the
system software CD that came with your computer. 

1 Start up your computer from the system software CD.

See Chapter 3, “Starting Up From a CD or Floppy Disk.”

2 Locate the Disk First Aid icon and double-click it to open the Disk First Aid program.

Data can be corrupted

m any time the computer is not shut down properly, using the Shut Down command

m when your computer freezes or crashes

m if SCSI devices are not properly connected and terminated
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3 Click the icon of the disk you want to test. 

Disk icons appear in a box at the top of the Disk First Aid window. 

4 Click Repair to begin testing and repairing the disk.

5 When testing and repair are done, choose Quit from the File menu.

If Disk First Aid cannot correct the problem

m Make sure you started up from the CD-ROM disc or floppy disk. See Chapter 3, “Starting
Up From a CD or Floppy Disk.” 

m Try running Disk First Aid a second or third time. Sometimes repeating the process
corrects the problem.

m Use the Drive Setup utility to update the driver.

m Use another disk repair or recovery program, such as Disk Doctor from Norton Utilities.
Sometimes another program will help you recover a corrupted disk.

m If you can’t repair the disk, you’ll need to reinitialize it. See the following section.

Initializing a hard disk

The hard disk inside your computer was initialized (formatted for use) at the factory, so you
should need to initialize it only if your hard disk is damaged and can’t be repaired with Disk
First Aid (or another disk repair program). 

You can initialize your internal hard disk using a program called Drive Setup, which is on the
system software CD-ROM disc that came with your computer.



Note:  If your hard disk is not an Apple hard disk, use the disk utility software provided by
the disk’s manufacturer instead of Drive Setup. 

1 Start up your computer from the system software CD. (See Chapter 3, “Starting Up From a
CD or Floppy Disk.”)

2 Locate the Drive Setup icon and double-click it to open the Drive Setup program.

3 In the list of drives, select the disk you want to initialize.

4 Click Initialize.

5 Click Quit when you see a message reporting that initialization was successful.

If initialization failed, choose Initialization Options from the Functions menu to select the
“Low level format” and “Zero all data” options. Then try initializing the disk again.

If initialization fails a second time, test your hard disk for damage, as described in the
following section. 

Warning  Initializing a disk erases all information on the disk. Before initializing your
disk, recover all the information you can and copy it to another disk.
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Testing your hard disk for physical damage
Note:  Testing the disk can take two hours or more, depending on the size of your disk.

1 Start up your computer from the system software CD. (See Chapter 3, “Starting Up From a
CD or Floppy Disk.”)

2 Locate the Drive Setup icon and double-click it to open the Drive Setup program.

3 In the list of drives, click the disk you want to test.

4 From the Functions menu, choose Test Disk.

5 When a message tells you that the testing is complete, click Quit.

If the test reveals a problem, the hard disk is probably damaged. Consult an Apple-authorized
service provider for assistance. (If you have a hard disk from another manufacturer, consult
that manufacturer for assistance.)
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C H A P T E R

Reinstalling Your Computer’s Software
Your Macintosh came with all the necessary system software installed on its internal hard
disk. You need to install system software on your internal hard disk only if

m you want to restore your system to its original factory settings

m you encounter software problems and need to reinstall system software 

m you want to add or remove system software components

m you have a new hard disk

Restoring custom settings and bundled software

Your computer may have come from the factory with the following: 

m additional applications such as ClarisWorks®

m customized system software settings such as System Folder protection

m the Mac OS Info Center

When you reinstall system software using the Mac OS 8 Installer described in this chapter, it
may not reinstall additional applications, reset customized settings, or reinstall the
information in the Info Center. 

If your computer came with extra application software, see the Read Me document on the
system software CD or floppy disks for instructions on how to restore that software.

Before installing system software

Before you begin the installation, do the following:

m Virus-protection and disk-security software: Turn it off.

m At Ease software:  Turn it off. For instructions, see the At Ease user’s manual.
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m PowerBooks:  Plug your PowerBook in and set it so it doesn’t go to sleep. Turn off
password protection in the Password Security control panel.

Important  It is highly recommended that you back up the data on your hard disk before
installing system software.

Installing Mac OS system software
Note:  If something goes wrong, see “Problems During Installation” later in this chapter.

1 Start up from the system software CD-ROM disc (or floppy disk).

For instructions, see “Starting Up from a CD or Floppy Disk,” earlier in this handbook.

2 Double-click the Mac OS Installer icon.

Note:  If you are installing from a floppy disk, the Installer may open automatically.

A welcome screen describes the steps in the installation process. To learn more about each
step, click the Help button (h) in the upper-right corner of the window.

Click to display
more information
about each step.



3 When you’re ready to begin, click Continue.  

The Select Destination dialog box appears.

If you want to perform a clean installation, skip to “Performing a Clean Installation,” later in
this chapter. Otherwise, continue with the following step.

4 Choose the destination disk from the pop-up menu and click Select.

The following dialog box appears.

5 Proceed to the next section, “Selecting Which Software to Install.” 

Selecting which software to install

After selecting a disk, you need to decide between a standard or a custom installation. The
standard installation installs all the software you need for your model of computer and is the
best choice to solve system software problems. A custom installation lets you add or remove
specific system software components.

Note:  Keep in mind that the more components you install, the more RAM is used and the
greater potential for software conflicts. Install only the items you expect to use. 

Standard installation:  Click Reinstall. Proceed to “Standard Installation,” next. 

Custom installation:  Click Add/Remove. Proceed to “Custom Installation,” later in this chapter.
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Standard installation

1 Follow the instructions on your screen until you see the Install Software window.

Note:  Your screen may look slightly different from the one pictured here. If you’re installing
from floppy disks, you won’t see all the choices that are available from the CD-ROM disc.

2 Select the software to install along with Mac OS 8.

Mac OS 8 will be installed automatically. Select or deselect other items you want to install.
Boxes that are checked are normally installed as part of the Mac OS.

3 Click Start.

Mac OS 8, and any other software you selected, are installed on your computer. 

4 When the installation has finished, click Restart in the dialog box that appears.



Custom installation

Note:  Your screen may look slightly different from the one pictured here. If you’re installing
from floppy disks, you won’t see all the choices available on the CD.

1 Select the software to install, the software to remove, or both.

You can choose whether or not to install Mac OS 8. If you select Mac OS 8, you can add or
remove specific components of Mac OS 8.

Note:  As you proceed, you’ll be able to determine exactly which components will be
installed or removed for the software you select. 

2 Click Start. 

If you see messages about problems with your hard disk, see “Problems During Installation,”
at the end of this chapter.

Installers for each of the components you selected will appear. For most of the components,
you just need to click the Install button. If you chose to install Mac OS 8 software, continue
with the following steps.

3 When you see the Mac OS 8 Installer’s welcome screen, click Continue.

If you want all the recommended components, click Install. Then skip ahead to step 7.

If you want to install or remove specific components, follow steps 4–6. 
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4 Open the pop-up menu and choose an item.

m If you want to install software, choose Custom Install.

m If you want to remove software, choose Custom Remove.

All available components for the software product appear in the Installer’s window.

5 Scroll through the list of components and click the checkbox next to each component you
want to install or remove.

You can see and select individual items within each component by clicking the arrow to the
left of the component, then clicking the item you want to install. For more information about
each component listed, click the box with the letter i in it to the right of the component.

6 Click Install or Remove.

The selected items will be installed on or removed from your computer. 

If you have problems while installing, see “Problems During Installation,” at the end of 
this chapter.

7 Repeat steps 5–8 for all the software you selected. 

After you finish installing or removing a software product, the Installer for the next product
you selected opens automatically.

8 When the installation has finished, click Restart in the dialog box that appears.
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Performing a clean installation

This section provides instructions for what is commonly called a clean installation of system
software. Performing a clean installation is more complicated than a standard installation, but
it is sometimes the best way to solve a persistent problem. A clean installation gives you a
fresh start with system software.

When you install system software using a clean installation, the Installer creates a new System
Folder on your hard disk. The old System Folder is renamed Previous System Folder. Since
your computer has a new System Folder, after a clean installation you must reinstall custom
fonts, extensions, and control panels that you’ve added to your system or that came with
utility or application programs.

Note:  Though application programs are not replaced or changed, some require system
software components that are removed from the System Folder during a clean installation.
You may need to reinstall these applications after you perform a clean installation.

1 Start up your computer from the system software CD-ROM disc (or floppy disk), as described
in Chapter 3, “Starting Up From a CD or Floppy Disk.”

2 Open the Mac OS Installer application.

3 In the Welcome box, click Continue.

The Select Destination dialog box appears.

4 Click the Perform Clean Installation checkbox so that it has a checkmark in it.

5 Click Select and follow the instructions until you see the Install Software dialog box.

6 Select the software products you want to install.

7 Click Start to install the software you’ve selected.
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A new System Folder is installed on your hard disk. (The old System Folder is renamed
Previous System Folder.) 

8 Restart your computer from the hard disk.

If the problem is solved:  See the following section that describes how to reinstall your
custom extensions, fonts, and control panels.

If the problem is not solved:  You can reinstall your custom extensions, fonts, and control panels;
or you can restore the previous system. These options are described in the following sections.

Reinstalling your custom extensions, fonts, and control panels

After a clean installation, you need to reinstall any custom extensions, fonts, and control
panels you were using. If you don’t have the original installation disks, you can drag items
one at a time from the Previous System Folder to the new System Folder. It’s a good idea to
restart your computer after you install each item, to see if that’s the item causing the
problem. After you’re sure that you’ve copied all the items you want into the new System
Folder, delete the Previous System Folder by dragging it to the Trash.

If the clean installation didn’t solve the problem

You may have a hardware problem. Consult an Apple-authorized service provider. 

You may want to revert to the Previous System Folder so that you do not have to reinstall
your custom extensions, fonts, control panels, and other items not installed with Mac OS 8.
To use the previous system again, follow the steps in this section.

1 Locate the currently active System Folder. It has a small picture of a Macintosh on it.

2 Open the System Folder and move the System suitcase into the Preferences folder. Close the
System Folder.

3 Rename the System Folder “Clean System Folder.”

4 Rename the Previous System Folder (the one you wish to use again) “System Folder.”

5 Open the new System Folder and double-click the System suitcase. Close the window that
appears, then close the System Folder.

The picture of a Macintosh should appear on the new System Folder’s icon. 

6 Restart your computer.

7 Drag the Clean System Folder to the Trash.

Warning  This procedure may not work. If it does not, you will have to perform a
clean installation again.
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Problems during installation

This section helps you solve problems you may encounter while installing your software.

You can’t start up the computer using the system software CD-ROM disc or
floppy disk. 

m Your computer may have located the system software on your hard disk before it located
the system software on the CD or floppy disk. If you have an external hard drive with
system software, the computer may start up from that device instead of the CD-ROM disc.

With the CD or floppy disk inserted, open the Startup Disk control panel and click the CD
or floppy disk icon. Then restart the computer. 

Note:  After you install the software, you’ll need to reselect your hard disk as the startup
disk. Open the Startup Disk control panel again and click the icon for your hard disk.
Then restart your computer.

The Installer cannot repair your hard disk.

m If you see a message that the disk can’t be fixed because a file is open, quit all programs.
Then try installing again.

m Use Disk First Aid or a third-party disk repair utility to see if it can repair the disk. 

If you don’t have a third-party utility, or if that utility can’t repair the disk either, you may
need to reinitialize the hard disk. See “Initializing a Hard Disk,” in Chapter 4. After you’ve
reinitialized the disk, try installing the system software again. 

You see a message that there’s not enough memory to use the Installer.

m Make sure you are starting up the computer from the system software CD-ROM disc or
floppy disk.

You see a message that the System file cannot be modified. 

m You may have virus-protection software installed that guards against modification of the
System file. Make sure you are starting up the computer from the system software CD-
ROM disc or floppy disk. Drag any virus-protection software out of the System Folder and
try installing again. You can put the virus-protection software back after installation. 

m The System and Finder files may be locked. To see if your System file or Finder file is locked,
open the System Folder and select the System or Finder icon. Open the File menu and
choose Get Info. To unlock the file, click the Locked checkbox to remove the checkmark.

m Try performing a clean installation of system software as described earlier in this chapter.

You see a message that the installation was not successful. 

m Make sure the system software CD (or floppy disk) is the startup disk, then try installing
system software again. If the installation is still not successful, try performing a clean installation.
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Responding to messages about your hard disk

The Mac OS 8 Installer checks the destination hard disk for errors before installing the
software. Additionally, if your hard disk was formatted with an Apple disk utility program, the
Installer updates the hard disk drivers with the latest version of the driver software. If your
disk drives are formatted with a disk utility from another company, the drivers are not updated.
You should use the third-party disk utility to update your hard disk before installing Mac OS 8.
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C H A P T E R

Contacting Apple for Help
If this handbook has not helped you solve your computer’s problem, contact Apple for
assistance. For information on how to contact the Apple Assistance Center, see the service
and support card that came with your computer. 

Have this information available before calling

Have the following information and software available when calling the Apple Assistance Center:

m what you have tried to do already

m a description of the problem (for example, the computer freezes in only one application
or at startup) 

m the type of computer, serial number, version of system software, third-party software,
external devices, internal devices, and so on (especially if the problem involves something
you have added to the computer)

m the system software CD, Disk Tools disk, or startup disk 

Be in front of the computer when you call so you can take steps the technician suggests. 

Using the Apple System Profiler

If you are able to start up your computer, the Apple System Profiler provides information
about your computer that will help you and the Apple Assistance Center troubleshoot your
computer. 

To open the Apple System Profiler:

m Choose Apple System Profiler from the Apple (K) menu to open the utility.

When you open Apple System Profiler, a System Overview window appears. Use the
commands in the Select menu to get more specific information about the hardware and
software used by your computer, or to go back to the System Overview window.
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To find out what the different items in the Apple System Profiler window mean, choose 
Show Balloons from the Help menu. Then point to the item you want to know about.

The Create Report command in the File menu lets you create a customized report of 
system software information. You can print this report by choosing the Print command from
the File menu.



Can’t Find It? 

See also Mac OS 

Help’s onscreen 

index. Open the 

Help menu and 

choose Help; 

then click the 

Index button.
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P R E F A C E

If Trouble Occurs
This book contains troubleshooting information for when you run into trouble with your
computer. If you are unable to solve your computer problems using this book, see Chapter 6,
“Contacting Apple for Help.”

Mac OS Help

If you need help using your computer, step-by-step instructions for using the Mac OS 
are available from Mac OS Help. To open the help system, choose Help from the Finder’s
Help menu.
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